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How to Use this Curriculum

This lesson plan is designed to teach the MEDCOM AHLTA Provider Satisfaction (MAPS) curriculum to Providers. Please note
that MAPS is most effective when taught in a one-on-one setting. Prior AHLTA knowledge and experience is assumed.

Note - There have been several suggestions for ways to alter the layout of the curriculum such that all non-Dragon areas can be
taught upfront. In this manner, the Dragon lesson can be extended and training can easily slide into on-the-job training without
having to break for the other lessons plans first. Additionally, there have been suggestions for making some aspects of this
curriculum classroom based. Now, training will still be done in a 1-on-1 format, but in some clinics it is very difficult for a
Provider to remain in his or her office and still maintain the necessary peace & quiet to complete the training. In these instances,
the Providers Dragon profile was set up and the MAPS portal demoed initially, or at a previous time, in the office and the rest of
the training was completed remotely. It is important, though, to remind the Provider to complete the Training Eval once he or she
returns to the office.

** UPDATED ** - See Appendix F for an example of a condensed MAPS Jump Start training curriculum. This one hour
overview can be completed in a classroom setting and will provide students the ability to create Dragon Profiles, complete basic
profile and vocabulary corrections, and gain an awareness of the MAPS tools.

Materials Needed

 MAPS Provider Lesson Plan
 MAPs Quick Reference Guide
 Access to MAPS Macros
 Access to AIMs forms (“NHP PC-Generic”, “Usability AIM FM”, “Usability AIM FM Procedures”)
 Link to Training Evaluation form
 Military Terms file
 Access to a JPG consent form
 Access to CTS/ATS
 Back-up CD for IMD with AUT & DM Macros
 Hardcopy of Anna Wunderlich’s SF600 (for Demo)

Tasks to be Completed Prior to Training

 Verify that Dragon, Asutype, MS OneNote, and PDF Professional are loaded and operational.
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 Load Military vocabulary (ranks and installations – MHS terms on Dragon).
 Provide MAPS Quick Reference Guide.
 Load/Verify free text AIM form (“NHP PC-Generic” or “Usability Form”).
 Reset AHLTA Training Database (use Encounter Data option only).
 Determine wireless vs. non-wireless environment.
 Determine static vs. roaming profiles.
 Verify Dragon Medical ‘Options’ settings (see Appendix B).
 Verify user has headset.
 Verify user system has had an audio check completed.

Tasks to be Completed by the end of Training

 Verify that the Provider has:
 Dragon Profile,
 Shortcut (Macro) in DM or AUT,
 Order Set,
 Favorites Lists, and
 AIM Form Loaded.

 Verify that the Provider can access MAPS Portal and it is bookmarked.
 Verify that the Provider knows how to get help.
 Verify that the Provider has completed the evaluation form.
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Format for the MAPS Curriculum

The following table outlines the course structure, estimated time for each section, key information to be communicated in class,
and instructor notes.

MAPS Overview

Duration Training Activities Instructor Notes
5 Minutes What is MAPS?

MAPS is a collection of tools and best practices requested and created by Providers,
for Providers to help document faster, more accurately and produce a readable note.
MAPS tools include:

 Tablet PCs,
 Dragon Medical 10 software,
 Asutype software, and
 MS OneNote & PDF Professional.

 Slide 4: What is
MAPS?

10 Minutes System Demo

Go to Appendix A
Explain: Instructor
needs to have set up a
complete encounter
using PC Generic to be
used for the Copy
Forward demo.
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Course Goal

The goal of this one-on-one training is to enable Providers to begin utilizing MAPS
tools immediately, and, in time, to begin to implement all of the tools and best
practices presented in the MAPS initiative. The course is designed to be teachable
within 4 hours, including three 10 minute breaks. This course assumes prior
AHLTA knowledge and experience.

Lesson Plan

 Introduction: What is MAPS (15 minutes)

 Lesson 1: Basic Tablet Overview (15 minutes)

 Lesson 2: Asutype (30 minutes)

 Lesson 3: Introduction to Dragon Medical 10 (65 minutes)

 Lesson 4: Introduction to Dragon Medical 10 Macros (40 minutes)

 Lesson 5: Reviewing AHLTA Core Competencies (15 minutes)

 Lesson 6: Introduction to MS OneNote (10 minutes)

 Lesson 7: Exporting MS OneNote using PDF Professional (5 minutes)

 Lesson 8: Reviewing the MAPS Quick Reference Guide (5 minutes)

 Lesson 9: Additional Training & Resources (5 minutes)

 Course Summary (5 minutes)
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Lesson 1: Basic Tablet Overview

Duration Training Activities Instructor Notes

Total Lesson
Time: 15
Min

Lesson Goal

The goal of this lesson is to enable the user to use the basic functionality of the
Tablet PC.

Learning Objectives

Upon completion of this lesson, the user will be able to:

 Identify the main tablet PC parts,
 Demonstrate Undocking and Docking the Tablet PC, and
 Use the Stylus Pen and Tablet Mode.

 Slide 7: Basic Tablet
Overview

Explain: Information is
available on Lenovo and
Fujitsu Tablet PC.

5 Minutes
Basic Navigation

Explain: General layout of the Tablet PC

 Battery
 Docking Connector
 Headset Jacks
 Wireless Switch
 Landscape/Portrait Buttons.

Explain: Location of
wireless button on the
front of the tablet.

10 Minutes
Docking & Undocking the Tablet PC

Demonstrate: How to dock and undock Tablet PC

Explain:

 Undocking Procedures (green light for Lenovo), and
 Docking Procedures.

Explain: The Tablet PC
Input Panel can be used
to enhance the
Provider’s coordination
with the stylus.

Explain: IMD can help
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Using the Tablet PC Stylus Pen

Explain: A stylus can be used like a pen, like a keyboard, and like a mouse, all at
once.

 Writing with the Pen
 Writing pad, character pad, keyboard buttons
 Erasing with Pen
 Securing the Pen to the tablet
 Using the Pen like a mouse
 Demonstrate right click feature.

Tablet Workstations

Explain: A Tablet PC is designed to be used wirelessly. However, it can be used
in “wired” environments.

Clinic workflow can be enhanced by setting up strategic ‘stations’ in your clinic
with power cords and by providing access points for connectivity (for non-
wireless).

Summary

In summary, we covered the following topics:
 Key Tablet Parts,
 Docking and Undocking the Tablet,
 Using the Stylus Pen, and
 Wireless vs. non-wireless environments.

Providers set up roaming
Dragon Medical profiles.

Explain: Becoming
familiar with the Tablet
PC will go a long way in
helping the Provider
begin using it as a
wireless “chart.”
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Lesson 2: As-U-Type

Duration Training Activities Instructor Notes

Total Lesson
Time: 40m

(including a
10 min break)

Lesson Goal

The goal of this lesson is to enable the user to use As-U-Type.

Learning Objectives

Upon completion of this lesson, the user will be able to:

 Open AUT;

 Explain the two main functions of AUT, which are Speller & Expander;

 Create Asutype shortcuts;

 Demonstrate basic knowledge of skills at operating and abilities in using
AUT application in conjunction with AHLTA during practical;

 Perform AUT spell checks; and

 Perform AUT Word corrections.

 Slide 38: Intro to
As-U-Type

Explain: Asutype is
commonly abbreviated
as AUT.

15 Minutes
Asutype Overview

Explain: Asutype allows you to replace large blocks of text and can even create
templates for you, saving you, and your team, time documenting.

1. Overview to Asutype

a. Introduce the key functionality of Asutype

b. Explain the functions of Expander and Speller

Explain: Shortcuts are
just another way of “re-
spelling” a word.
Explain how the SFS
(Single Female Smoker)
shortcut works.

Explain: Techs can use
Asutype to pre-populate
notes for Providers,
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2. Open/Close Asutype/

a. Open: Desktop Icon or Start Menu->Programs

b. Click the OK button on the quick tip message if it appears.

c. Close: Right click the Asutype icon in system tray, click Exit.

Asutype Shortcuts

1. Create Shortcuts/Macros

a. Click the Asutype icon on the task bar.

b. Click to select the Expander function.

c. Click the Shortcut Lists button

d. Enter a meaningful name for the shortcut in the Hot Text field.

e. Copy Dr. Walker’s document – Questionnaire for female non-smoker
into the content for the shortcut.

f. Click Add>Save>OK

2. Use Shortcuts (Macros) in AHLTA or Other Documents

a. Open PC-Generic AIM form.

b. Position the cursor in a free text box where the shortcut will be inserted.

c. Enter the Hot Text assigned to the shortcut and press the Space Bar.

d. Modify the text, as appropriate.

particularly in the
Screening and HPI
sections.

Superuser Tip: Offer to
explain Tabs of Asutype
if time is available.

Tools: Verify female
non-smoker macro is
loaded onto desktop

Explain: Be sure to
explain that the term
‘shortcuts’ and ‘macros’
are interchangeable
within Asutype.

Explain: Additional
shortcuts are available
on the MAPS portal

Superuser Tip:
Advanced Shortcuts can
be created using
variables.

Explain: Explain
advantages of using the
same AIM form within
the same clinic.
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e. Press Enter key to keep text.

f. Explain the Option Menu

1) From the main menu, select Options to make any preference
changes

g. Explain using Asutype Help

1) Click the Asutype icon on the task bar.

2) Click Help on the upper left corner of the Asutype window that
pops-out.

Exercises

Execute the following exercise to create a shortcut to automatically enter the
current date and time.

1. Right click on the Asutype icon in the system tray

2. Select Shortcut Lists

3. Enter “datetime” in the Hot Text box

4. Select Hot Code button

5. Select Preset Date and Time

6. Select the appropriate format for date (e.g. 12/15/08)

7. Select Preset Date and Time

8. Select the appropriate format for time (e.g. 20:39)

Explain: PC Generic
creates a readable form.
You can select Note
View within any AIM
form to get a preview of
what it will look like in
note form.

** UPDATED ** - If
the site has AHLTA
located on a remote
server, AUT will needed
to be loaded in the same
location to work with
AHLTA. This will
require the use of a
common drive to store
user specific AUT
shortcuts. Check the
VMC Portal for specific
work instructions, and
AUT settings relating to
this functionality.
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15 Minutes
Asutype Speller

Explain: Asutype can be used to make spelling corrections shortcuts/macros.

1. Correct word mistakes with Asutype

2. Open WordPad and type a word, misspelling it, e.g. “phlem”

3. A drop down list provides the following correction recommendations:

a. Press 0 to add the word and make this a default correction

b. Or, select the number corresponding correct spelling

4. Verify that the updated word is correct.

Adding Words to the Dictionary

1. Type MYALGIA.

a. Press F2 to add word into dictionary.

b. Check the Spelling Dictionary to see if new word was added.

2. Select Asutype>Spelling Dictionary. Type new word to add it to the
dictionary.

Importing Words into Asutype

1. Open Spelling Dictionary.

2. Select User Tab>Import.

3. Browse and add .txt file.

** UPDATED ** - There is a medical spelling dictionary available from Fanix
that is free and makes the spelling functionality of AUT easier for Providers. See

Explain: Phlegm is
intentionally misspelled
here.

Example Words for
Asutype Lessons:
 Angioedema
 Dysmennoreah
 Coloposcopy
 Myalgia
 Dyspnea
 Dyslipidemia
 Metorraghia
 Immunologic
 Hemoptysis
 Cellulitis
 Infarction
 Cardiomyopathy
 Epidural
 Acroosteolysis

Explain: The advantages
of enabling/disabling
Asutype (i.e., interfering
with other applications)
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the Fanix AUT homepage link: http://www.fanix.com/files/medical.spelling for
more information relating to this.

Disable/Enable Asutype

1. Right click the Asutype icon in system tray, click Disable or Enable (Note:
when in Disabled mode the Asutype icon in the system tray has an X)

2. Modify the text as appropriate.

Note - Please highlight to the Providers that you can disable this spell check
function while still using Expander.

Exercises

Execute the following exercises:

 Correcting words, and
 Adding words to dictionary.

SUMMARY

In summary, we covered the following topics:
 AUT overview,
 Opening/Closing Asutype,
 Practicing creating and inserting shortcuts,
 Practicing inserting the HPI:URI Form for within AHLTA,
 Importing words into AUT,
 Explaining the two main functions of AUT,
 Creating Asutype Shortcuts, and
 Performing AUT spell checks.

10 Minute Break
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Lesson 3: Introduction to Dragon Medical 10

Duration Training Activities Instructor Notes

Total Lesson
Time: 85m

(including a
10 min break)

Lesson Goal

The goal of this lesson is to teach the purpose and core functionalities of Dragon
Medical 10.

Learning Objectives

Upon completion of this lesson, you will be able to:
 Launch Dragon Medical,
 Perform the Dragon audio volume and audio quality checks,
 Create individual voice profiles using Dragon wizard,
 Identify the DragonBar,
 Apply key Dragon options and settings,
 Turn the microphone on and off,
 Put the Dragon microphone in sleep and awake modes,
 Use Dictation and Correction, and
 Use the Vocabulary.

 Slide 49: Intro to
Dragon Medical 10

5 Minutes Introduction

1. Overview of Dragon Medical.

2. Review the training objectives.

3. Coach users how to plug in headset or handheld microphone.

4. Coach users how to properly position a headset or handheld microphone.

Coach users how to start/stop Dragon Medical.

Explain: Performing just
a 5 minute training
tutorial session will
increase accuracy by
20%.
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20 Minutes Creating a New User Profile

The following provides instructions for completing the New User Wizard:

1. Coach users how to create a user and select from a list.

2. Coach users to select the correct vocabulary. This is very important for
developing Dragon Accuracy.

3. Coach users how to add a dictation source.

4. Coach users during the enrollment process.

5. Set best practice options for user profile.

6. Use the “Talking to your computer” dictation choice when completing the
verbal profile. This option is easier to read and conveys important
information about how voice dictation software works.

Explain: Perform your
microphone check in
your normal working
environment such that
Dragon can adjust for the
same background noise.

Explain: Skip the
“vocabulary optimizer”
step because it can take
30 minutes.

Trainer Tip: Standard
Default Dragon User
Settings are located in
Appendix B.

5 Minutes Dictation Tips

Use the following tips for dictation:

1. Speak clearly and enunciate.

2. Pause to prepare dictation mentally prior to speaking.

3. Speed is not an issue.

4. Dictate punctuation.

5. Don’t look at the screen when dictating.

6. Know correct microphone position – 2” from mouth.
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7. Know how to turn microphone on/off –awareness of when on and off. Be aware
that Dragon can have a delay turning off the microphone if it is still processing
text. Note: It keeps listening until the microphone icon turns yellow or red.

8. Set-up voice profile in actual environment (simulates actual background noise).

9. When Dragon misrecognizes a word, do not overtype it or respeak it. Use
Dragon to correct it. Dragon is always learning and this will improve its
accuracy.

10.Users need to add the “general” vocabulary to their profile if they want to use
Dragon for non-medical purpose (like email).

11.Users should create their default verbal profile using the Dragon headset for
accuracy. They can “add a new source” to their profile using their own
headset/mic at a later time.

12.Practice, Practice, Practice.

5 Minutes The DragonBar

The following provides information on the DragonBar:

1. Identify DragonBar.

2. The DragonBar can be placed in the system tray (in bottom right corner).

a. Select the DragonBar>Tools>Options >View

b. Select Tray Icon Only in the Mode section.

3. Coach Provider on Microphone awareness (icon/sleep/on/off). Be aware that
Dragon can have a delay turning off the microphone if it is still processing
text. It keeps listening until the microphone icon turns yellow or red.

Explain: Colored circle
in DragonBar – “Select
and Say Indicator”
 Green – Dragon

enabled in open
window

 Gray – Dragon not
enabled

 Orange – hidden
dictation box – you
are dictating but not
into shown window.

Explain: Oval shaped
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“Volume Display
Indicator”
 Yellow – low

volume.
 Green – normal

volume.
 Red – high volume.

Superuser Tip: Offer to
explain the entire
DragonBar if time
permits.

10 Minutes Dictating/Correcting Reports

The following provides an introduction to dictation and voice corrections:

1. Coach users how to dictate using DragonPad.

2. Help users understand the purpose of the Results box.

3. Coach users how to perform basic navigation commands.

4. Coach users how to use the Selection & Correction features.

5. Coach users how to use the Spell dialog.

6. Coach users how to perform basic navigation commands.

7. Coach users how to perform basic formatting commands.

Explain: It is easy to
forget you are wearing
your headset. Be careful
when walking away
from your Table PC that
you are not ‘attached’ to
it via your headset.

Trainer Tip: Dragon
Dictation & Correction
tips are located in
Appendix B.

Explain: In some
situations you may need
to delete a word from the
Dragon vocabulary to
train it to effectively
recognize some words.
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5 Minutes Correction Tips

Explain: When Dragon misrecognizes a word, do not overtype it or respeak it.
Use one of the Dragon correction methods below. Dragon is always learning and
this will improve its accuracy.

These are five options (in order of suggested sequence) for making corrections
within Dragon:

1. Using the Correction Menu:

a. Say “Select” <word>

b. (If you see correct word) Say “Choose” <number>

2. Using the Spell and Train Words Dialog Boxes:

a. Say “Select” <word>.

b. Say “Spell That”.

c. Spell the word.

d. Press OK.

3. Using the Train Words Dialog Boxes:

a. Say “Select” <word>.

b. Click “Train That”.

c. Say “Go”.

d. Say the word.

e. Say “Done”.

4. Using the Vocabulary Editor:

a. On the DragonBar click Words -> View/Edit and the Vocabulary Editor will
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appear.

b. Type the word in the Written Form field.

c. Type the phonetic pronunciation of the word in the Spoken Form field.

Note: The word will now appear twice, once without a spoke form and once
with. You can delete or train the unspoken form.

5. Using the Word in a Phrase:

a. If word is still misrecognized, add a phrase that contains the word.

b. For example the word “MAPS” could be trained as “MAPS initiative” for
context.

15 Minutes Building and Importing Vocabulary

The following provides an introduction to the Dragon Vocabulary Editor:

1. Give them a tour of the Vocabulary Editor.

2. Coach users how to add word.

3. Coach users how to train words.

4. Coach users how to add spoken forms.

5. Coach users how to edit and delete words.

Explain: While macros
are saved immediately,
custom words and
corrections are saved
manually or at close.

10 Minute Break
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Lesson 4: Introduction to Dragon Medical 10 Macros

Duration Training Activities Instructor Notes

Total Lesson
Time: 50m

(including a
10 min break)

Lesson Goals

The goal of this lesson is to create, save, and import Macros within Dragon
Medical 10.

Learning Objectives

Upon completion of this lesson, the user will be able to:

 Understand the similarities between macros and AUT shortcuts,
 Create a basic macro within Dragon Medical 10, and
 Save and import a macro.

 Slide 95: Dragon
Medical Macros

25 Minutes Custom Commands & Macros

The following provides an beginners overview of Macros:

1. Coach user how to create a basic Text and Graphics Command.

2. Identify the MyCommands window in the Command Browser.

3. Coach user to edit and delete a basic Text and Graphics Command.

Explain: Within Dragon
the terms “Custom
Command” and “Macro”
are interchangeable.

Explain: You will use
the URI Macro as an
example; however, if the
Provider has a clinic-
specific Macro, then that
can be used instead.

Superuser Tip:
Advanced macros using
user keystroke, mouse
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movement, and mouse
click memorization tools
can be built within
Dragon.

Superuser Tip:
Advanced macros using
embedded variables and
commands can be built
within Dragon.

Superuser Tip: Dragon
Macros and Advanced
Scripting Tips are
located in Appendix C.

10 Minutes Practice with AHLTA

1. Coach user how to dictate, select, correct, and edit in AHLTA or other
application.

2. Use Dragon in the SO section with List Temp and/or AIM form.

a. Load Template or AIM form.

b. Click in Free Text field.

1) Dictate using Dragon.

2) When using existing macro, say the command name.

3. Use Dragon in the AP section.

a. Select Plan/Comments to open free text box.

Trainer Tip: Use the
sample medical dictation
text in Appendix D.

Explain: Remind the
user to say punctuation
while dictating.

Explain: DO NOT use
the “Undo That”
command. It closes
AHLTA.
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1) Dictate using Dragon.

2) When using existing macro, say the command name.

b. Select E&M codes within Disposition screen.

4. Use AMEDD E&M coding cheat sheet in MAPS Quick Reference Guide.

Macro exercise in AHLTA

Practice using these sample URI Macros for AHLTA
Utilize Dr. Walker’s URI MACROS: HPI URI, ROS URI, PE URI, Assessment
and Plan URI.

5 Minutes Dragon Medical Help

1. Refer to DragonBar>Help for answers to common questions.

2. Should Dragon have a serious error capture the Dragon Log, select
Start>All Programs>Dragon Medical 10>Show Dragon Log.

3. Should Dragon have to be shut down through Task Manger, then select
Ctrl-Alt-Del>Task Manager>Process Tab> Select “NatSpeak.exe” >End
Process.

Explain: Check the
MAPS portal for FAQ
for Dragon.
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Lesson 5: Reviewing AHLTA Core Competencies

Duration Training Activities Instructor Notes

Total Lesson
Time: 15m

Lesson Goal

The goal of this lesson is to enable the user to utilize the core functionalities within
AHLTA to complete a patient encounter, as well as understand the key elements of
coding and key AHLTA best clinical practices.

Learning Objectives

Upon completion of this lesson, the user will be able to:

 Create a Personal Favorite List of Diagnoses,
 Create a Personal Favorite List of Procedures,
 Create an Order Set,
 Use the Copy Forward feature of AHLTA,
 Use DX Prompt, and
 How to select E&M Codes.

 Slide 119: AHLTA
Core Competencies

15 Minutes
AHLTA Core Competencies

Explain: This list of AHLTA Core Competencies provides you with the proven
winners in AHLTA. The best of the best modules and workflow practices to get
your encounter documented quickly and accurately.

1. Review core AHLTA modules and skills.

a. Create a Personal Favorite List of Diagnoses.

b. Create a Personal Favorite List of Procedures.

Explain: Mention
examples of Clinical best
practices

 Team Based
Documentation
(“techs aren’t just
vitals junkies”)

 Patient folders (w/
Med and Problems
reconciliation)
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c. Create an Order Set.

d. Use the Copy Forward feature of AHLTA.

e. Use DX Prompt.

2. Describe how to manually enter an E&M code.

a. In Disposition module, click Selection Tab.

3. Choose E&M code (check with coders).

Exercises

Execute the following exercises:

 Add Daignosis to Favorite List,
 Add Procedure to Favorites list,
 Use Dx Prompt,
 Add an Order Set, and
 Use Copy Forward.

Summary

In summary, we covered the following topics:
 Used an Encounter Template,
 Customized an Encounter Template, and
 Created an Order Set in A/P.

 Pre-Appointment
questionnaires

 Screening Macros
 Posting Macro cheat

sheets in rooms.

Explain: Have Coders
review your Favorites
Lists to be in line with
the clinic and MTF’s
lists.

Explain: If using free
text, the Provider has to
manually enter E&M
check codes. It is
important that Providers
check with Coders to
ensure correct E&M.

Explain: When using
NHP PC Generic or
Usability AIM form,
entering history allows
you to copy forward in
subsequent encounters.

10 Minute Break
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Lesson 6: Introduction to MS OneNote

Duration Training Activities Instructor Notes

Total Lesson
Time: 10m

Lesson Goal

The goal of this lesson is to enable the user to use the key features of MS
OneNote.

Learning Objectives

Upon completion of these modules, the user will be able to:

 Open MS OneNote,
 Create an MS OneNote notebook,
 Import a .jpg file (consent form) into a MS OneNote page,
 Annotate a .jpg file in MS OneNote, and
 Print to PDF Professional.

 Slide 136: Intro to
MS OneNote

10 Minutes
MS OneNote

Demonstrate: How to use MS OneNote to save encounter information and then
copy it into AHLTA.

1. Open MS OneNote.

2. Create an MS OneNote notebook.

3. Create an MS OneNote section.

4. Create an MS OneNote page.

Explain: MS OneNote
has numerous, simple
note taking functions and
has powerful organizing
capabilities.

Explain: MS OneNote
is your go-to tool if
AHLTA goes down.
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5. Import a .jpg file into an MS OneNote page.

6. Annotate a jpg file in MS OneNote.

Exercises

Execute the following exercises:

 Practice capturing encounter information into MS OneNote and
 Check for understanding and answer participant questions.

Summary

In summary, we covered the following topics:
 Display a previous patient encounter,
 Append a narrative to a completed encounter, and
 Amend a completed encounter.

Explain: MS OneNote
can be used to sign
consent forms.

Tools: Use Blank
Consent form .jpg

Explain: You can use
the Windows + S
keystroke to highlight
your text. Your screen
will turn grey and you
can use your mouse to
select the area you want
put into the clipboard.
An MS OneNote page is
also created. This area
can now be pasted in the
Add Note of AHLTA.
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Lesson 7A: Exporting MS OneNote using PDF Professional

Duration Training Activities Instructor Notes

Total Lesson
Time: 3m

Lesson Goals

The goal of this lesson is to enable the user to export items into AHLTA using
PDF Professional.

Learning Objectives

Upon completion of this lesson, the user will be able to:

 Save an annotated .jpg file to PDF Professional or PDF Creator and
 Insert a PDF file into AHLTA.

 Slide 143: Exporting
to PDF & AHLTA

Explain: How PDF
Professional can export
images into AHLTA

** NEW ** Explain: PDF
Converter Professional is
also called PDF Pro and
PDF Converter.

3 Minutes
PDF Professional

Demonstrate: Explain how any file saved to PDF can be converted to a sizable
image that can be included in the Add Note section of an AHLTA encounter.

1. Print a file into PDF Professional.

2. Open this file using PDF Professional.

3. Use Selection icon from standard tool bar.

4. Highlight the area of the PDF to be copied.

5. Open up the Add Note section of the desired patient.

Explain: AHLTA Add
Note has size limitations
which PDF Professional
can account for with its
sizing tool

** NEW ** Super user
Tip: You can use
Dragon to create a macro
to automatically copy
files from MS OneNote
into Add Note.

Explain: If a PDF printer
is not available on the
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6. Paste image and save.

Exercises

Execute the exercise: Export a *.jpg into Add Note using PDF Professional into
the CTS.

Summary

In summary we learned that PDF Professional can copy images into AHLTA Add
Note.

Provider machine, you
can pull the .jpg file into
MS Paint, sign the note,
copy and paste it into
Add Note.
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Lesson 7B: Setting a Default PDF Viewer

Duration Training Activities Instructor Notes

Total Lesson
Time: 2m

** NEW ** - Lesson Goals

The goal of this lesson is to enable the user to change the default PDF Viewer on
their table to be Adobe, should they choose.

Be certain that

1. That PDF Converter is already installed on the Provider’s tablet

2. PDF Converter is, in fact, their default viewer

** NEW ** - Learning Objectives

Upon completion of this lesson, the user will be able to:

 Change a default PDF viewer

 Slide 160: Setting a
Default PDF Viewer

Explain: How Installing
PDF Converter can
chance the default PDF
viewer on the Tablet.

Explain: A Default
Viewer is the software
correlated with a file
extension, such as MS
Word for all “.doc” files
and MS Excel for all
“.xls” Files

2 Minutes
PDF Professional

Demonstrate: How double clicking on a PDF file will bring up PDF Converter.
Explain how this setting can be easily changed back to Adobe Acrobat/Reader
should the Provider prefer it. This activity does not uninstall PODF Converter, nor
remove the print driver it provides. It just allows the user to view PDFs using a
software other than PDF Converter. The user will still be able to open PDF
Converter manually and then open any PDF they choose.

1. While in your file explorer window ‘Right Click’ on any PDF file. This will
bring up a file options window. Select ‘Open With…’.

Tip: Use the ILT slides
here (164-171) to clearly
illustrate how these steps
are performed.

Super user Tip: Show
the Provider some of the
advanced conversion
capabilities of PDF
Converter. Explain to
them the advantages of
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2. Select ‘Adobe Reader’ and check the box below for ‘Always use this the
selected program to open this kind of file’. PDFs will now always open into
Adobe.

3. When installing PDF Converter, be sure to uncheck the box for ‘Set PDF
Converter as your default…’, to prevent this default being changed. Paste
image and save. Depending on how PDF Converter is installed, though, IMD
may have to do this prior to the SMS push.

Exercises

** NEW ** - Double click on other PDF files and note that they now open up in the
default viewer program.

Summary

In summary we learned that how to set up a new default PDF Viewer.

PDF Converter over
Adobe or PDF Creator.
Getting Providers
comfortable with the
new software will make
them more likely to try it
out.
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Lesson 8: Reviewing the MAPS Quick Reference Guide

Duration Training Activities Instructor Notes

Total Lesson
Time: 5m

Lesson Goal

The goal of this lesson is to step through the materials made available in hardcopy
to each Provider via the MAPS toolkit.

Learning Objective

Upon completion of this lesson, the user will be able to identify the elements of the
MAPS toolkit.

 Slide 164: MAPS
Quick Reference
Guide

5 Minutes MAPS Quick Reference Guide

Explain: The MAPS Quick Reference Guide provides you with the very
essentials to get you up and running with the MAPS suite of tools and best
practices.

1. Cheat Sheet for Dragon Commands.

2. Cheat Sheet to Build/Import Macro Instructions for Dragon Medical.

3. Dragon AHLTA Tips.

4. Cheat Sheet for Asutype Usage and Building/Downloading a Shortcut macro.

5. Coding Cheat Sheet.

6. AHLTA Core Competencies.

Explain: The MAPS
Quick Reference
Guide is only a
temporary solution.
The MAPS portal has
all the latest versions
of these documents as
well as countless
others.
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7. How to Find and Download an AHLTA Template.

Summary

In summary we reviewed the contents of the MAPS Quick Reference Guide.
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Lesson 9: Additional Training & Resources

Duration Training Activities Instructor Notes

Total Lesson
Time: 5m

Lesson Goal

The goal of this lesson is to explain the additional resources and training
opportunities available to the Provider.

Learning Objectives

Upon completion of this lesson the user will be able to:

 Access the Virtual MAPS Community (VMC) Portal and

 Schedule additional MAPS training.

 Slide 172:
Additional Training
& Resources

5 Minutes
MAPS Portal

Explain: The VMC Portal has additional information and resources

 Shortcuts,
 Macros,
 Answers to Questions,
 Cheat sheets & Quick Reference Guide, and
 Videos.

To access the VMC Portal:

1. Connect to the VMC Portal at https://vmc.amedd.army.mil.

2. Review available resources.

Explain: Be sure to save
the MAPS Portal as a
shortcut on the Providers
computer.
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Additional Training

Additional training is provided at:

 VMC portal at https://vmc.amedd.army.mil
 Nuance Webinars: www.nuance.com/mhs.

Explain: MAPS points-of-contacts:

 Sustainment Trainer
 IMD POC
 Help Desk contact information.

Exercises

Execute the exercise: Connect to VMC Portal.

Summary

In summary, we covered the following topics:

 The Virtual MAPS Community (VMC) Portal.
 Provider MAPS POCs.
 Additional training options.

Explain: Providers can
begin using MAPS tools
slowly, perhaps at the
beginning and end of the
day, or before lunch.

Trainer Tip: Follow up
support is critical to
MAPS effectiveness.
Find time to check in
with Provider a day or so
after training to see what
questions he or she has.



MAPS Provider Lesson Plan 33

Course Summary

Duration Training Activities Instructor Notes

5 Minutes Briefly summarize the course and open to questions and answers

 Basic Tablet Overview

 Introduction to Asutype and Asutype macros/shortcuts

 Introduction to Dragon Medical 10 and Dragon Medical 10 macros

 Reviewing AHLTA Core Competencies

 Providing Examples of other clinical best practices & team based
documentation

 Introduction to MS OneNote

 Exporting MS OneNote using PDF Professional

 Reviewing the MAPS Toolkit

 Additional Training & Resources

Training Evaluation

Complete outline course evaluation MAPS portal at https://vmc.amedd.army.mil.

Note - Some Providers have requested waiting to complete the course evaluation for
a few days/weeks such that he or she could get more comfortable with the MAPS
tools. This is fine, but please follow up to make sure this eval is eventually
completed.

 Slide 176: Course
Summary

Tip: Connect to MAPS
Portal to complete
course evaluation at this
point as well.
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Appendix A: MAPS System Demonstration

Duration Training Activities Instructor Notes

10 Minutes
Pre-Demo Setup

1. Turn on Dragon.

2. Turn on AUT.

3. Have access to following artifacts:

a. NHP PC-Generic.txt

b. Anna Wunderlich SF600

c. A list of your shortcuts & macros.

4. Turn on ATS.

5. Set Change Selections to Today plus Incomplete.

6. Co-Sign note for Anna Wunderlich.

7. Have created a previous signed appt for Anna Wunderlich (see next section).

8. Set up CTS Options.

a. Turn off Reminders.

b. Turn off Active Medications for Options for SF600.

c. Uncheck both S/O defaults.

9. Have access to the following Macros (based on Questionnaire female
nonsmoker.doc and Complete URI.doc).

a. Female Non-Smoker Shortcut (nsfemale).

b. “Insert HPI URI”.

c. “Insert ROS URI”.

d. “Insert PE URI”.

Explain: The CTS has
been renamed the ATS
in AHLTA 3.3.
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e. “Insert AP URI”.

Steps for Creating Previous Encounter for Anna Wunderlich

1. Open SO and use PC-Generic.

2. Dictate or enter the following Current Meds:

 ZYRTEC PO 10 MG 1 TAB EACH DAY AS NEEDED

 FLONASE NAS 0.05% SPRAY 2 SPRAYS EACH NOSTRIL EACH DAY.

Note - Meds available in AHLTA 3.3.3.2 may differ slightly.

3. Chief complaint: URI.

4. Social History: non-smoking female (using Asutype).

5. HPI: Use Dragon to Dictate:

HPI:
Patient with several day history of upper respiratory infection symptoms to include nasal
congestion, non-productive cough, mild malaise and myalgias. Patient denies fever or chills,
no shortness of breath or chest pain.
Patient is healthy with no major medical problems.
No recent travel or unusual exposure.
No history of reactive airway disease.

6. ROS: URI macro using Dragon (Name: “Insert ROS URI”)

ROS:
Generalized malaise, mild myalgias, nasal congestion, sneezing and non productive cough.
No headache, no visual symptoms, no neck stiffness, no ear pain, no shortness of breath, no
chest pain, no palpitations, no wheezing. No abdominal pain, mild decreased appetite but
taking po fluids well, no nausea or vomiting, no diarrhea or constipation, urinating normally,
no dysuria, no frequency. Patient denies any joint pain or rashes.

7. PE: URI macro using Dragon (Name: “Insert PE URI”).
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Physical Exam:
General: no apparent distress, alert, non-toxic appearing
HEENT: sclera non-icteric, mild conjunctival injection, TM's: normal, non-erythematous,
good light reflex. Nares: congested Sinuses: non-tender Pharynx: membranes moist, non-
erythematous, no exudate, uvula non-swollen and midline
Neck: supple, no adenopathy, no masses
Chest: non labored and not tachypnic, no accessory muscle usage, no wheezing or rhonchi
CV: regular rate and rhythm, no murmur
Abdomen: soft, non-tender
Extremities: no joint tenderness
Skin: good turgor, no jaundice, no rash, no lesions
Neuro: grossly intact, no obvious sensory or motor deficits noted, normal gait

8. A/P: Insert diagnosis of Upper Respiratory Infection from Copy Forward
Template.

9. Insert assessment URI macro using Dragon (Name: “Insert AP URI”).

Assessment and Plan:
Viral upper respiratory infection: no evidence of invasive bacterial infection, non toxic and
well hydrated. Most likely patient has a self limiting viral infection. Do not see where any
further testing or imaging is necessary at this time.
1. Treatment Supportive care, rest, good hygiene, encourage to take oral fluids.
2. Tylenol 325mg two tablets every four hours as needed for fever or pain
3. Afrin 2 puffs in each nostril every 12 hours for no more than three days
4. Sudafed 30mg one tablet by mouth every six hours as needed for congestion
5. Patient is to return to the clinic or Emergency Room if symptoms worsen or

change significantly. The patient verbalized understanding and agreement of treatment
plan.

10.Sign & Save SF600.

Note - See Appendix E for sample SF600

Setting the Scene for the Demo

Sir, I would like to show a brief demonstration of the suite of MAPS tools we are
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going to go over today while using AHLTA.

Note - Please make it clear as you go through the Demo when MAPS tools are being
used. Providers have given feedback that they were not able to tell from the demo
what new functionality was being featured. As the demo is given, point out where
MAPS tools are being used. For example:

 “Now watch what happens when I enter the letters ‘nsfemale’ into the social
history section, do you see how the text came up? This is an example of As-U-
Type”

 “I am going to use the microphone to dictate my note, notice how what I say
appears in this free text window. This is done using Dragon Medical 10.”

 “I will now give an example of a Dragon macro, notice what happens in the
URI box when I say “insert URI”

 “I am going to use the copy forward command to bring Anna Wunderlich’s
previous SF600 forward. Now you are already familiar with Copy Forward,
but I’d like you to notice what happens when I bring it into an AIM form. I am
going to use the same AIM form this previous SF600 was originally created
in, and notice how these text boxes automatically populate.”

MAPS Demo

1. Create new appt for AW.

2. Open Appt for AW.

3. Go to previous encounters for Anna.

4. Find your signed encounter and click copy forward.

5. Open SO.

6. Copy Forward Template should be showing.

7. Click on PMH Tab – click both Medications and Social History (make active).

8. Go to template drop down Box and select NHP PC-Generic.
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9. When PC Generic comes, you should see medications and your social history.

10.Show the medication box – explain you can make corrections typing or dictating.

11.Show the social history and explain that this can be done by tech or nurse.

12.Show how easy it is to put in the social history w/ Asutype.

a. Delete the current social history.

b. Use Asutype shortcut NSFemale to insert standard text for a non smoking
female. Explain that that text can be edited.

13.Demonstrate dictating the HPI (Use Dr. Walker HPI Text).

14.Demonstrate dragon macro in the ROS, and PE, explain that it can be edited.

a. Click on 2nd patient tab for ROS and PE.

b. Insert ROS URI.

c. Insert PE URI.

15.Go to AP.

16.Enter diagnosis in the search box or dictate diagnosis (URI).

17.Click on second patient note tab.

18.Click on the Comments/Plan and use macro to enter Assessment and Treatment.

a. Insert AP URI.

19.Close Note and notice overall readability of SF600.

20.Go to disposition and show how to select the E&M.

a. Click Selection tab to manually select E&M code.
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Appendix B: Dragon Default Options

Default Dragon Option

Tools->Options Recommended Default Settings changes
Correction tab:

 Enable double-click to correct
 Show no more than 5 choices
 Automatically add words to vocabulary.

Commands tab:
 Require "Click" to select hyperlinks in HTML windows.

View tab:
 Auto Hide delay: 5 seconds.

Hot Keys tab:
 Microphone on/off. It is recommended that a hotkey be set, however it is important

to verify that this key will not conflict with CHCS (F10 is a popular choice). The
default is the “+” key on the numeric pad.

Text-to-speech tab:
 Move Speed setting 3 clicks to the right.

Miscellaneous tab:
 Automatically save user files.

Dictation Box tab:
 Keep transferred text in clipboard when the Dictation box is closed.

Data tab:
 Save recorded dictation with document: Never.
 Disk space reserved for playback: 100 MB.
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Tools->Formatting Recommended Default Settings changes
General tab:

 Date format: DD/MMM//YY
 Insert two spaces after period
 Numbers, if greater than or equal to 0.

Numbers, Units, and Dates tab:
 Rewrite "cc" after a number as "mL".
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Appendix C: Dragon Medical Macros & Advanced Scripting Tips

Dragon Medical Macros Tips

Use the following Dragon Medical Macro Tips:

1. When editing or creating macros, create a custom name for the “User-Defined
Group” folder for organization purposes.

2. Dragon does not allow the user to ‘Save’ a macro with errors.

3. Macros created in Dragon 9 will not import into Dragon Medical (i.e., Dragon
10).

4. When naming macro use multiple words and be consistent with naming
conventions, e.g., use ‘insert URI HPI’.

5. Check the Plain Text box to maintain current formatting.

6. Dictate the name for the Macro rather than type it.

7. Do not make one word macro names.

8. Group your macros functionally and use a consistent naming convention to keep
macros organized and easily available.

9. When dictating a word that is also a command or macro name be sure to say it
fluidly with the rest of the sentence, otherwise the macro will be triggered.

10.If the macro or shortcut is an extensive amount of text, practice writing in
AHLTA so you can be aware of formatting and text character limits.

Superuser Tip: Advanced macros using keystroke, mouse movement and
mouselick memorization tools can be built within Dragon.
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Superuser Tip: Advanced macros using embedded variables and commands can be
built within Dragon.

Advanced Scripting Tips

Explain: See Scripting for Dragon NaturallySpeaking 10, by Larry V. Allen, for a
good book on Dragon scripting.

Basic Scripting Terms include:
 ALT = %
 CTL = ^
 SHIFT = +
 F10 = {F10}
 ENTER = {ENTER}
 WAIT .5 = wait 1/2 second
 SENDKEYS "^A", 1 = This command does not allow the macro to begin

next command until previous step completed. Use this instead of WAIT . The
“1” equals TRUE in this statement

 BEEP = makes beep (good audio cue that macro is done)
 Single quote in front to make a comment.
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Appendix D: Sample Medical Dictations

Sample Medical Text 1

John is a very pleasant 30-year-old man with a history of coronary disease with 3 vessel
involvement. He has had Class II angina pectoris with some exacerbations in the past, which has
come under control with medical therapy. He has had no unstable or poor prognostic symptoms.

Mental Status Examination, General Appearance: The patient is a 38 year old male who appears
his stated age. There was no psychomotor retardation or agitation. There were no abnormal
movements or posturing. He was sociable, maintained good eye contact and gave relevant answers
to questions. He was cooperative throughout the interview.

Degenerative osteoarthritis, right knee, varus aligned knee, radiculopathy, right leg and discogenic
facet degenerative changes. Continue trial of anti-inflammatories, continue physical therapeutic
measures and structured aquatic therapy.

Sample Medical Text 2

The patient has been a smoker of two packs per day for 24 years and is known to be hypertensive
since age 20. He has elevated cholesterol LDL and triglycerides in company with reduced HDL
level. On examination he appears as a plethoric man who presents older than his stated age of 55.

The patient received three stitches and was given care instructions. He was sent home
accompanied by her husband and told to return in one week to have the stitches removed.

History of Drug and Alcohol Abuse: The patient has history of cocaine use. He began using
cocaine in 1975 and used it three times a week. He quit in 1992 and has no history at present. He
drank socially in the past but does not drink at present.

Explain: Copy
this into a
separate
document with
increased font
size and spacing
for readability.

Explain: The
point of this
dictation
exercise is to
force a mistake
for correction
purposes.
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Sample Medical Text 3

Mr. Thibodeaux is a very pleasant 30-year-old man with a history of coronary disease with 3
vessel involvement. He has had Class 2 angina pectoris with some exacerbations in the past,
which have come under control with medical therapy. He has had no unstable or poor prognostic
symptoms.

Sample Medical Text 4

Colonel Wilkinson is a 57 year-old Caucasian female, well-known to me, who presents for a
follow-up visit for high blood pressure. Patient denies any complaints or problems. She has had
around a 6 to 7 pound weight loss since the last time I saw her and says she has been very careful
about her diet. She denies any chest pain, shortness of breath, diarrhea, constipation, vomiting,
nausea, dysuria. No other complaints at all. Last mammogram June 6, 2007 which showed no
evidence of malignancy. Last sigmoidoscopy was done one year ago. At that time it was
recommended that she repeat in one year secondary to some redundancy of the colon and some
internal hemorrhoids, although no masses were noted at that time. Patient also with hysterectomy
and currently on Premarin, doing well. Has a history of glaucoma for which she is followed by
ophthalmology.

Sample Medical Text 5

I was asked by Dr. Sutaria to speak with Mrs. Melko to discuss issues regarding preterm delivery
at 23 weeks gestation. I visited with her in her room for approximately 15 minutes, and discussed
multiple issues regarding complications of premature delivery. Mrs. Melko was told that the infant
was at risk for developing intraventricular hemorrhage, and that the gestational age and the infant's
degree of illness would factor into the risk of bleeding. She was told that all premature infants
have a higher risk of neurologic problems compared to term infants, and that a small bleed would
not increase the risk beyond this elevated baseline, but that a large bleed would increase the chance
that the baby could have severe neurologic handicaps, and mental retardation and cerebral palsy
were specifically mentioned. Mrs. Melko was also told about retinopathy of prematurity. She was
told that the infant would likely need to be hospitalized until about the due date, but could be
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earlier or later than this, depending on the clinical course of the infant. All of her questions at this
time were answered, but she was told that we would be available to speak with her again anytime
she would like.

Sample Unusual Names

The patient will follow up with Dr. Paderofsky. Fusilev was administered intravenously.

The patient will follow up with Dr. Balorama. Cleviprex was administered intravenously.

Sample New Drugs

Tapentadol Tablets:

Tapentadol is a centrally acting oral analgesic indicated for the relief of moderate to severe acute
pain.

Banzel (rufinamide) Tablets

Treatment for: Lennox-Gastaut Syndrome

Banzel (rufinamide) is a triazole derivative antiepileptic drug for the adjunctive treatment of
seizures associated with Lennox-Gastaut syndrome

Sample Military Text

The M998 High Mobility Multipurpose Wheeled Vehicle (HMMWV, pronounced "Humvee", also
dubbed "Hummer") is the most commonly deployed tactical vehicle used by the Armed forces of
the USA and its allies. The original vehicle offers excellent road and cross-country mobility. It was
designed in a variety of configurations; primarily for utility, logistical and scout missions. Where
active combat role was considered, the Humvee was selected for its excellent cross country and
road, air and helicopter mobility and load capacity.
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Sample Dragon Template with Variables

Insert headache history

Patient presents who complains of headaches for the past []. Patient reports that the headaches are
mainly located in the [] part of the head. Duration of individual headaches is []. The usual
frequency is every []. Associated symptoms are generally []. Patient has been taking for pain
relief: [] Precipitating factors include []. Patient denies a history of recent head injury.

Sample Dragon Template with Fill-Ins

Patient presents who complains of headaches for the past 6 months. Patient reports that the
headaches are mainly located in the left part of the head. Duration of individual headaches is 24 to
36 hours. The usual frequency is every week. Associated symptoms are generally nausea and
sensitivity to light. Patient has been taking for pain relief: Excedrin, Motrin, naproxen.
Precipitating factors include red wine and beer. Patient denies a history of recent head injury.
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Appendix E: Completed Demo SF600

Patient: WUNDERLICH, ANNA W Date: 02 Jan 2009 0807 MST Appt Type: ACUT$
Treatment Facility: CHCSII ITT
Facility

Clinic: CHCSII Test Clinic Provider: USER, TEST

Patient Status: Outpatient

Reason for Appointment: PC GENERIC DEMO

AutoCites Refreshed by USER, TEST @ 02 Jan 2009 0809 MST
Problems
Chronic:
• Allergic rhinitis

Allergies
• No Known Allergies

Vitals
Vitals Written by USER, TEST @ 02 Jan 2009 0855 MST
BP: 120/75, HR: 72, RR: 12, T: 98.7 °F, WT: 125 lbs

SO Note Written by USER, TEST @ 02 Jan 2009 0854 MST
Chief complaint
The Chief Complaint is: URI.
History of present illness

The Patient is a 25 year old female.

Patient with several day history of upper respiratory infection symptoms to include nasal congestion, nonproductive cough, mild malaise and myalgias. Patient denies
fever, chills, no shortness of breath or chest pain.
Patient is healthy with no major medical problems.
No recent travel or unusual exposure.
No history of reactive airway disease.
Current medication
Zyrtec P.O. 10 Mg One Tab Each Day As Needed Next Is Flonase NAS 0.05% Spray 2 Sprays Each Nostril Each Day.
Personal history
This visit is not deployment related. Patient not late on menses, not trying to become pregnant and is not breast feeding. Patient has not expressed any depressive
symptoms, no problems with activities of daily living, no concerns over domestic violence, and no dietary concerns. Patient is a non smoker and occasionally
consumes alcohol on a social basis. No communication barriers, no barriers to learning, and no conflicts with religious practices identified.
Review of systems
Generalized malaise, mild myalgias, nasal congestion, sneezing and non productive cough. No headache, no visual symptoms, no neck stiffness, no ear pain, no
shortness of breath, no chest pain, no palpitations, no wheezing. No abdominal pain, mild decreased appetite but taking po fluids well, no nausea or vomiting, no
diarrhea or constipation, urinating normally, no dysuria, no frequency. Patient denies any joint pain or rashes.

.
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Physical findings
General: no apparent distress, alert, non-toxic appearing
HEENT: PERRLA, sclera non-icteric, mild conjunctival injection, TM's: normal, non-erythematous, good light reflex. Nares: congested Sinuses: non-tender Pharynx:
membranes moist, non-erythematous, no exudate, uvula non-swollen and midline
Neck: supple, no adenopathy, no masses
Chest: non labored breathing, no accessory muscle usage, no wheezing or rhonchi, no dullness to percussion
CV: regular rate and rhythm, normal S1, physiologic split S2, no murmur or rub, no S3
Abdomen: normal contour, normal bowel sounds, non-tender, no guard or rebound, no organomegally or masses
Extremities: full range of motion, no joint tenderness or calor
Skin: good turgor, no jaundice, no lesions
Neuro: grossly intact, no obvious sensory or motor deficits noted, normal gait
.

A/P Written by USER, TEST @ 02 Jan 2009 0906 MST
1. UPPER RESPIRATORY INFECTION: Viral upper respiratory infection: no evidence of invasive bacterial infection, non toxic and well hydrated. Most likely patient
has a self limiting viral infection. Do not see where any further testing or imaging is necessary at this time.

Treatment:
1. Supportive care, rest, good hygiene, encourage to take oral fluids.
2. Tylenol 325mg two tablets every four hours as needed for fever or pain
3. Afrin 2 puffs in each nostril every 12 hours for no more than three days
4. Sudafed 30mg one tablet by mouth every six hours as needed for congestion
5. Patient is to return to the clinic or Emergency Room if symptoms worsen or change significantly. The patient verbalized understanding and agreement of
treatment plan.

Disposition Written by USER, TEST @ 02 Jan 2009 0908 MST
Released w/o Limitations
Follow up: with PCM.

Signed By USER, TEST (Training Tool Application, CHCSII ITT Facility) @ 02 Jan 2009 0909
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Appendix F: MAPS Jump Start Curriculum

1. Introduce concept of Dragon and MAPS initiative.

a. Show Dr Walker’s video

b. Show Dr Steffensen’s example of dictate into generic AIM form

c. Provide clinicians with realistic expectations of support that will be provided with the following information:

“It is extremely important that you understand that Technical support assets were not provided with the MAPS initiative.
Each site has been asked to provide this support within the framework of their normal business so technical support may not
be readily available. Voice profiles are stored on our servers which allow you to use Dragon from any computer within the
facility as long as that computer has Dragon loaded. We do not know how such a mass activation of so many voice profiles
will affect the servers where these profiles are stored. There may be unforeseen technical glitches that could slow the
deployment process. This is an ambitious plan, so we beg your indulgence as we push forward.”

2. Describe and demonstrate steps to find and load Generic AIM form

3. Show users how to find Dragon icon and create user profile

a. Launch Dragon

b. Demonstrate how to place microphone correctly, ensuring that white dot points towards mouth

c. Perform audio and quality checks

d. Create profile (ensure that naming convention of FIRST NAME, SPACE, LAST NAME is explained)

e. Briefly show Dragon bar, microphone colors and how to open profile

f. Demonstrate how to turn microphone on and off (NO explanation of how to set keys for this)
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4. Demonstrate effective dictation using basic voice commands

a. New Line

b. New paragraph

c. Choose (word or number) - Spell that (or double click on word)

d. Unselect that

e. Delete that (NOTE: Ensure users understand that removing text will DECREASE accuracy in Dragon if they are

removing text because Dragon made an error in transcribing. The words MUST be trained if Dragon is to maintain

accuracy of around 99%.

f. Cap that, All Caps that

g. Bold <word or phrase>

h. Open quote “ , close quote “

i. Open paren (, close paren )

j. Spell that

k. Train that


